
Interconnect Mediated Access 31.0

Connection Guide
How to set up and connect to IMA

October 17, 2011




Connection Guide—IMA 31.0
Document information
Document information

If you use this guide, please let us know at imadocs@centurylink.com. We 
welcome your feedback on this document.

The versions of this guide for the new release are listed below:

Document date Description

September 19, 2011 
[draft]

Draft guide for CMP review posted at
http://www.centurylink.com/wholesale/cmp/review.html

September 26, 2011 Final guide posted at
http://www.centurylink.com/wholesale/cmp/
review_archivesystem.html

October 17, 2011 Final guide posted at
http://www.centurylink.com/wholesale/ima/gui/index.html

You can find guides for prior releases at
http://www.centurylink.com/wholesale/cmp/review_archivesystem.html.

Change log
Changes to IMA for this release are provided through CMP (change 
management process) at http://www.centurylink.com/wholesale/cmp/
index.html.

CMP revisions specific to this guide are as follows:

• None.

Other changes for this release:

• Rebranded from Qwest to CenturyLink.

• The URLs in this document substitute “centurylink” for “qwest”.

• Removed obsolete references to Netscape and Netscape-related processes 
such as downloads and digital certificate exporting.

• Hardware requirements for IMA are updated to match the needs of java.

Copyright and Trademarks
©2001–2011 CenturyLink, Inc. All Rights Reserved. The CenturyLink mark, 
pathways logo and certain CenturyLink product names are the property of 
CenturyLink, Inc. All other marks are the property of their respective owners.
2 October 17, 2011
http://www.qwest.com/wholesale/ima/gui/index.html

http://www.centurylink.com/wholesale/cmp/index.html
http://www.centurylink.com/wholesale/cmp/index.html
http://www.centurylink.com/wholesale/cmp/review_archivesystem.html
http://www.centurylink.com/wholesale/cmp/review_archivesystem.html
http://www.centurylink.com/wholesale/cmp/review.html
http://www.centurylink.com/wholesale/ima/gui/index.html
http://www.centurylink.com/wholesale/cmp/review_archivesystem.html


Contents

Document information  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .2
Change log . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .2
Copyright and Trademarks . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .2

1—Getting started
CenturyLink SYADs. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .5
CLECs . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .5
System security . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .6
IMA hours (Mountain Time) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .6
Additional resources . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .7

Web sites . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .7
Documents . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .7

2—Requirements
Software requirements . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .9
Hardware requirements (minimum)  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .9
Downloading the Java plug-in  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .10

Plug-in installation notes  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .11

3—E-business Internet connection
Requesting a digital certificate . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .13
Downloading your digital certificate  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .14
Verifying the installed certificate  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .16
Modifying the java.policy file . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .18
Importing your digital certificate to Internet Explorer . . . . . . . . . . . . . . . . . . . . . . . . .19

4—Connecting to IMA
Logging in to IMA for the first time . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .23
Creating your personal profile  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .24
Modifying your personal profile  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .25
Changing your password . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .25

Index
 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .27
October 17, 2011 3
http://www.qwest.com/wholesale/ima/gui/index.html



Contents Connection Guide—IMA 31.0
4 October 17, 2011
http://www.qwest.com/wholesale/ima/gui/index.html



1
Getting started

This guide provides

• basic information about Interconnect Mediated Access (IMA)
• software and hardware requirements
• instructions for

• configuring Internet Explorer
• modifying the java.policy file
• Internet access to IMA

This guide is intended for employees of the ISC (Interconnect Service Center), 
IWSC (Interconnect West Service Center), the LOC (Listing Operation Center), 
and Competitive Local Exchange Carriers (CLECs).

This guide assumes you have a background in telecommunications local 
service.

IMA is available for use by CLECS in the legacy Qwest territories within the 
former 14-state Qwest region.

CenturyLink SYADs

CenturyLink™ system administrators create IMA accounts for all CLECs, 
including establishing the first CLEC system administrator and maintaining 
user profiles.

CLECs

CLECs interact with IMA on two levels:

• administrators create and manage all CLEC user accounts
• users manage all service requests through IMA

IMA allows CLECs access to local service elements of the CenturyLink network 
and electronic access to its legacy operations support systems (OSS).

CLECs use IMA to create local service requests (LSRs) and submit them to 
CenturyLink for processing. LSRs contain the information CenturyLink needs to 
create service orders for the CLECs.
October 17, 2011 5
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System security

IMA provides a secure environment for its users.

System security Description and access

Username and password IMA usernames and passwords for CLEC system 
administrators are obtained from a CenturyLink system 
administrator. CLEC system administrators must receive 
these before they can access IMA.

CLEC system administrators give CLEC users their 
username and password. To ensure security, new users 
should change their individual password the first time they 
log in to IMA. (See “Changing your password” on page 25.)

You can change your password at any time. (System 
administrators can also reset passwords.)

User PIN and Corporate ID PINs and IDs are obtained from a CenturyLink Wholesale 
Markets service manager. Only users who have these 
credentials can enter the IMA secure environment and 
access its data, preventing unauthorized persons from 
gaining access to protected information.

IMA provides an additional level of security by letting the CLEC system 
administrators decide the access rights users will need—administrator 
privileges or user privileges. Access rights define specific privileges users have 
to operate within IMA. If a user performs the tasks of both an administrator 
and a user, this user requires two IMA usernames and passwords, one as a 
user and one as an administrator.

An administrator can inactivate a user when necessary, preventing the user 
from accessing IMA and data stored in any of the databases. For more 
information on CLEC system administrative privileges, see the CLEC System 
Administrator’s Guide (http://www.centurylink.com/wholesale/ima/gui/
index.html).

IMA hours (Mountain Time)

Monday–Friday 6 a.m. to midnight

Saturday 6 a.m. to 9 p.m.

Sunday 11 a.m. to 7 p.m.
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Additional resources

Web sites
IMA Access

https://ima.centurylink.com/ima

Products and Services

http://www.centurylink.com/wholesale/pcat/index.html

CenturyLink E-Business—Digital Certificate Procedures

http://ecom.centurylink.com

Wholesale Customer Contacts business procedure

http://www.centurylink.com/wholesale/clecs/escalations.html

Wholesale Resources—IMA

http://www.centurylink.com/wholesale/ima/index.html

Documents
In addition to this document, CenturyLink provides four other guides to help 
you use IMA.

The first three guides are available at
http://www.centurylink.com/wholesale/ima/gui/index.html

• CLEC System Administrator’s Guide—guidelines for managing CLEC users’ 
accounts

• Facility-Based Directory Listings Guide—guidelines for submitting orders 
for facility-based directory listings

• IMA User’s Guide—guidelines for preparing, submitting, and following up 
on LSRs

The fourth guide is available at
http://www.centurylink.com/wholesale/training/coursecatalog.html:

• Loop Qualification and Raw Loop Data CLEC Job Aid—guidelines for 
retrieving raw loop data and for checking whether a loop qualifies (for 
CenturyLink HSI/Broadband Service or for unbundled ADSL service)
October 17, 2011 7
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Requirements

This chapter describes hardware and software requirements for IMA. If non-
IMA applications are running concurrently with IMA, these requirements may 
need to be increased.

Note: When a new version of IMA is installed, you must log out of IMA 
and log back in to continue working.

Software requirements

Important: CenturyLink only supports and certifies Windows XP as the 
operating system for IMA. CenturyLink recommends you 
use Internet Explorer 6.0 as your browser when running 
Windows XP. IMA may function using different browsers and 
Windows operating systems, however, CenturyLink will not 
be responsible for any problems encountered when using 
operating systems other than Windows XP.

• Microsoft Windows XP

• Internet Explorer 6.0 (recommended)

• Java plug-in 1.4.2_xx or higher for Internet Explorer. However, CenturyLink 
recommends that Internet Explorer users upgrade to java plug-in 
1.4.2_08.

Hardware requirements (minimum)

• Intel Pentium 233 MHz

• 17-inch SVGA monitor (800 x 600 resolution or higher)

• SVGA video card with 2 MB memory

• 96 MB RAM

• 56 Kbps modem or dedicated LAN connection to CenturyLink

• 200 MB free disk space (after all software installation and Windows virtual 
memory file allocation)
October 17, 2011 9
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Additional memory (RAM) and a faster network connection and CPU may 
improve performance of IMA.

Downloading the Java plug-in

Important: CenturyLink recommends that you download your 
browser before installing the Java plug-in. If you 
download a browser after installing the Java plug-in, you 
must re-install the Java plug-in. The plug-in is required to 
access IMA PreOrder/Order/PostOrder functions. 

The following IMA GUI Web site includes the link for the Java plug-in:
http://www.centurylink.com/wholesale/ima/gui/faq.html

1 Follow the online instructions for downloading the Java plug-in.

If the Java plug-in has not already been installed, an installation link for it 
appears on the Plug-in Not Loaded window in IMA, which appears only when 
PreOrder/Order/PostOrder is launched for the first time and the Java Plug-in 
has not been installed.

2 Click Click here to go to the install page.

3 To download the executable file for the Java plug-in, click on Download by 
Clicking Here. Save the downloaded file to your desktop so you can find it 
easily.

4 Return to your desktop.

5 To install the Java plug-in, double-click the file and follow the instructions.

6 Close all applications and restart your browser.
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Note: It might be possible for an unsupported browser to run the 
PreOrder/Order/PostOrder GUI after the Java plug-in has been 
installed. If you encounter problems, however, CenturyLink first 
recommends that you install a supported browser.

Plug-in installation notes
If an administrator installs the Java plug-in on an NT system and then you try 
to run an applet requiring the Java plug-in, IMA’s HTML page will check for an 
installed Java plug-in, find it, and think everything is okay. But when IMA 
invokes the applet, you will see a small window with no title and no message. 
The only functional items on the window are the Close button (X) in the upper 
right-hand corner and an OK button in the center. If this situation occurs, the 
Java plug-in should be re-installed by you. This scenario also occurs in a dual-
boot situation, as described below.

In a dual-boot situation, where multiple operating systems are installed on the 
same machine, the Java plug-in installation must be done twice. This is 
because

• each operating system has is own system registry, which must be updated 
individually with the plug-in.

• the software library for each system must be updated with the plug-in.

Therefore, the downloaded plug-in .exe file must be run under each operating 
system. This will update the two registries and place the libraries in the proper 
directories. 

If the installation is done under only one operating system, the applet will 
think the plug-in has been properly done under both, since the libraries will be 
present in the directories; however, the applet will only run properly on the 
operating system where the installation was performed. Under the other 
operating system, you will see the same small, empty window described 
previously.
October 17, 2011 11
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E-business Internet connection

CenturyLink E-business digital certificates (or digital IDs) are issued for each 
of your employees. They are required for each personal computer used to 
access CenturyLink systems via the Internet.

E-business digital certificate registration is a one-time process and must be 
renewed every five years.

You must first request a digital certificate before starting the registration 
process.

Requesting a digital certificate

The CenturyLink E-Commerce group obtains the VeriSign and legacy Qwest 
cobranded digital certificates needed to access IMA via the Internet.

The digital certificate process is administered by the CenturyLink WSSA 
(Wholesale Systems Security Administration) group. This group has 
responsibility over these certificates for end users, including revocation of a 
certificate and updating user information.

To request a digital certificate

1 Contact your CenturyLink service manager at:
http://www.centurylink.com/wholesale/clecs/accountmanagers.html

Note: You may also go to the Wholesale Systems Web site at
 http://www.centurylink.com/wholesale/systems/
generalinfo.html for request information and forms.

2 Fill out the digital certificate request form.

3 E-mail the completed form to your CenturyLink service manager.

The CenturyLink service manager verifies that the information is complete 
and correct and then forwards your request to WSSA. The WSSA sends 
your information to ECOM to assign the certificate and PIN information.

Important: All digital certificate requests must go through a 
CenturyLink service manager. Under no circumstances 
should you e-mail your request directly to the CenturyLink 
Wholesale Systems Security Administration group. Your 
request will not be processed.
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http://www.qwest.com/wholesale/ima/gui/index.html

http://www.centurylink.com/wholesale/clecs/accountmanagers.html
http://www.centurylink.com/wholesale/systems/generalinfo.html
http://www.centurylink.com/wholesale/systems/generalinfo.html
http://www.centurylink.com/wholesale/systems/generalinfo.html


3—E-business Internet connection Connection Guide—IMA 31.0
Downloading your digital certificate
Once your request is processed, the information is updated in the LDAP server 
and an e-mail reply is sent to you. Please allow a minimum of 48 hours to 
process and update security databases.

The e-mail contains the following information you must have before registering 
your digital certificate:

• digital certificate number

• PIN

• instructions for their use

Once you’ve registered your digital certificate, you must have the following 
before you can access IMA:

• your company’s corporate ID

• username

• password

Downloading your digital certificate

To begin the downloading process

1 Go to the CenturyLink Online Service Center Web site at (http://
ecom.centurylink.com).

2 From the Online Service Center menu, select Begin Digital Certificate 
Download Process.
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Downloading your digital certificate
Important: Digital certificates must be downloaded within 30 days of 
receipt. Digital certificates not downloaded within this time 
are removed from the system. If your digital certificate has 
been removed, you need must request a new one.

3 Fill in the User ID and PIN fields and click Accept.

Note: The private key is used by Internet Explorer to encrypt data that 
is transmitted from the CLEC to CenturyLink. It is stored only 
on the workstation and browser version from which the 
key was generated. Multiple digital certificates may be stored 
on a single workstation. However, if another workstation or a 
different browser version is used, a new private key must be 
generated and stored on that workstation.

4 Click Yes if you receive an ActiveX Control warning.

5 Click Yes at the security warning to proceed with installation.
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Verifying the installed certificate
When the client digital certificate is fully loaded on the workstation, the 
registration process is complete.

Verifying the installed certificate

1 Choose Tools > Internet Options in your Internet Explorer browser.

2 On the Content tab, choose Certificates.
16 October 17, 2011
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3 Double click on the certificate’s name.

4 View the General tab.

5 View the Certification Path tab.
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Modifying the java.policy file

Important: CenturyLink highly recommends that you create a backup 
copy of the java.policy file.

1 Using Windows Explorer, access the java.policy file from the folder 
C:\ProgramFiles\Java\j2re1.4.2_xx\lib\security (where xx is either 05 or 
08. If you have folders for both j2re1.4.2_05 and j2re1.4.2_08, use the 08 
folder).

2 Select the java.policy file.

3 Select Edit > Copy, then select Edit > Paste.

A copy of the java.policy file appears in this same folder.

4 Using WordPad, open the java.policy file.

5 Edit the java.policy file by adding the following 2 lines:
18 October 17, 2011
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• permission java.util.PropertyPermission "javax.net.ssl.*", "read,write";
• permission java.util.PropertyPermission "user.home", "read";
Insert these lines at the bottom of the file just above the }; symbol.

Tip: If you’re reading these guidelines in Adobe Acrobat, you can use 
the Select Text tool to select the lines of text, copy them, and 
paste them into the java.policy file. Copy and paste one line of text 
at a time eliminating the leading bullet.

6 Save and close the java.policy file.

If you are unable to access the IMA PreOrder/Order/PostOrder functions after 
completing the above procedure, do one of the following:

• If you do not receive an error message, close all active windows and 
programs and restart your computer.

• If one of the following error messages displays, follow the instructions and 
try accessing IMA PreOrder/Order/PostOrder again:

If this error message displays, check the java.policy file and make sure the 2 
new additional lines you entered are accurate and placed correctly.

If this error message displays, check to make sure the certificate password 
and name are correct. The password is one you previously entered for the 
certificate or qwest1. The certificate name in your UserID folder must be 
QwestIMACertificate.p12.

Note: For digital certificate assistance, call the CenturyLink Wholesale 
Systems Help Desk (888-796-9102, option 2).

Importing your digital certificate to Internet 
Explorer

This section is for current and new Internet Explorer users and explains how to 
“move” your digital certificate.
October 17, 2011 19
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Importing your digital certificate to Internet Explorer
All requirements for modifying the java.policy file must be completed before 
continuing.

1 Open Internet Explorer.

2 From the Tools menu, select Internet Options.

3 Click the Content tab.

4 Click Certificates.

5 Click Import to activate the Certificate Wizard.
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6 Click Next.

7 Type the URL or select Browse to locate your certificate. Your certificate 
should be located at C:\Documents and Settings under your specific 
UserID and the file name of the certificate should be 
QwestIMACertificate.p12.

8 Click Next.

9 In the Password field, type qwest1. This password is case-sensitive.

10 Click Next.
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11 Leave the settings at their default positions and click Next.

12 Click Finish.

The name of the certificate appears in the Certificates list box along with 
a confirmation message.

13 Click OK and close all active windows.
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Connecting to IMA

If you are accessing IMA over the Internet, several factors external to 
CenturyLink (such as your Internet service provider—your ISP—and Internet 
traffic) may impact response time.

If you’re accessing IMA using a digital certificate, use this URL: https://
ima.centurylink.com/ima. (CenturyLink recommends that you bookmark this 
URL.)

Logging in to IMA for the first time

The Interconnect Login window ensures that only authorized users access 
IMA. To log in, you need your corporate ID, username, and password. (You can 
get this information from your system administrator.) 

See “System security” on page 6.

1 In the Interconnect Login window, type your corporate ID, username, 
and password. (These fields are case-sensitive.)

2 Click Login.

The first time you log in to IMA, your password is the same as your 
username. As soon as you create your personal profile, you should change 
your password. (See page 25.)
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Creating your personal profile

The first time you log in to IMA, you must fill in your personal profile before 
you can go on to other tasks. Your personal profile contains information that 
CenturyLink uses to contact you.

Tip: Administrators—you might want create a joint e-mail account and 
phone number so that all users have access to this e-mail or phone 
number in case of absence, emergency, or work flow. This group 
e-mail and phone number can then be entered in the individual 
user’s profile.

1 Fill in the fields. (Floor and Room/Mail Stop are optional.)

a For your telephone and fax numbers, use the format 555-555-5555.

b Fill in your e-mail address, fax number, or both to indicate how you 
want to receive system notifications.

2 Click Update Database. (If you click Logout, your profile won’t be saved 
and you’ll still need to create your personal profile next time you log in.)

3 Click Return to Main Menu.

The Interconnect Functions window appears. Depending on your access 
level, you may see fewer options.
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Important: Be sure to use buttons within IMA. Don’t use the browser’s 
buttons (e.g., Back) or you may get an error.

Modifying your personal profile

After you have created and saved your personal profile, you can modify it 
further as needed.

1 In the Interconnect Functions window, click User Administration.

2 Click in each field to be modified, and change the information. (Remember 
to use the format 555-555-5555 for the telephone and fax numbers.)

3 Click Update Database.

4 Click Return to Main Menu.

Changing your password

For security reasons, you should change your password often.
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Changing your password
1 In the Interconnect Functions window, click Set Password.

2 Do the following:

In this field … Type …

Old Password Your current password

New Password Your new password (6–8 characters, at least one of which is 
a number or special character)

Re-Type New Password

3 Click Set Password.

IMA changes your password.

4 Click Return to Main Menu.
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